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CHAPTER 3

There are a few techniques | will be using again and again throughout the tutorials
in the Create Charts chapter. As I've said before, I'm a minimalist with design, but
function wins out over form. There are times | might need to litter a chart with a
text box that's larger than | feel comfortable with. But if there’s an urgent issue that
needs to be addressed, communicating that issue in a way that grabs management’s
attention outweighs my design preferences. However, in the absence of an exigent
circumstance like that, I'm always looking for ways to weed out unnecessary pixels
in my chart.

To that end, I'll give you some tools in this chapter that will help you format your
charts in a way that will throw the spotlight where you want: on your data! Chart noise
vies for that spotlight. By the time you get to the end of this chapter you'll have the
skills you’ll need to tamp it down.

You may choose to skip this chapter and just earmark it for when tutorials reference a
section. But there’s potential benefit to biting the bullet and reviewing the techniques
listed here because you might find yourself in a situation where a recipient of one
of your visualizations challenges you on a design decision, and you will need to be
armed with alternatives to appease his concerns.

For example, let's say you remove gridlines from your chart, and your boss tells you
she needs them to understand the chart. If you know the alternatives to just throwing
gridlines into a chart, you could suggest some alternatives, like bringing the data
into the chart with data labels. If she is recalcitrant, you can at least make those
gridlines as unobtrusive as possible by setting them to a light color—like gray—or
reducing their transparency.

TWO MAIN OBJECTIVES

When I'm assessing the effectiveness of a visualiza-
tion’s design, I'm mostly looking for three things:

+ Does it align with the organization’s brand?
+ s it free from clutter?
+ s it the best chart for what's being communicated?

The last item will be addressed ad nauseam in the
Create Charts chapter. By the time you get to the end,
you will have learned how to create 60+ visualizations

in Excel. But I'll address the first two objectives in
this chapter.

ALIGNMENT WITH BRANDING

Many organizations have branding guides. And many
more should have one but don’t. Many times brand
managers in these organizations hawk over compliance
with their branding guide but give nary a thought to the
charts and other visualizations they publish and distribute
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to customers, clients, board members, and other stake-
holders. This is an oversight—and one that | will address
relentlessly throughout the book.

FREEDOM FROM CLUTTER

Microsoft doesn’t do you any favors with their default
visualizations when it comes to decluttering. They
are rife with chartjunk, a term coined by Edward Tufte
in his 1983 book The Visual Display of Quantitative
Information. Chartjunk—such as unnecessary grid-
lines (hate them!), axis labels that could be sent packing
with data labels, 3-D effects, etc.—is distracting and
can cause spikes in anxiety. It's like your viewers'
eyes don’t know where to land. They just dart back
and forth, undirected, in search of relevance. I've seen
some things. And some stuff....

Note: I'm not a fan of chart junk being one word, so
I'll separate them in future references. It's not you,
Edward; it's me! *laughs awkwardly*

This chapter will help you prepare your charts for
presentation by handing you a tool belt you will use
again and again in the Create Charts chapter to get the
junk out of your trunk.

A TALE OF TWO ORGANIZATIONS

DOJ’S DISASTROUS CHARTS

One of the saddest examples I've seen of the impact
of this kind of oversight can be found on the U.S.
Department of Justice (DOJ) website. The DOJ’s
branded palette contains an amalgam of powerful
colors, as shown in the screenshot of their homepage
below, taken in January 2018 (Fig 3.1).

Butthenthey use charts like this one, whichwasincluded
in their Asset Forfeiture Program slideshow. You can
view it here: bit.ly/mdsem-doj-chart-01 (Fig 3.2).
There are a number of issues with this visualization:

+ It uses Excel’s default theme.

+ It uses Excel's default colors instead of the DOJ’s.
+ The markers serve no real purpose.

+ The data table redefines unnecessary.

+ The gridlines are unnecessarily thick.

+ The mixture of line formatting is busy.

+ The mean line is too thick and the wrong color.

+ It's not clear what the mean line is an average of?
Total deposits? Total expenses? Net?

Fig 3.1: The DOJ’s branding is a treasure trove for a skilled data artist.
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Fig 3.2: Not using their stunning color palette in their visualizations
is a crime against data. Cuff ‘em and stuff ‘em!

Fig 3.3: Just say no to 3-D charts—and neon! #chartmullet

They published an even more egregious example of a
3-D column chart they published on their Merger Review
Process Initiative — Backgrounder page, which you can
view here: bit.ly/mdsem-doj-chart-02 (Fig 3.3).

There are a number of issues with this visualization:

+ [t uses Excel's default theme.
+ It doesn't use the DOJ's branded colors.

+ It uses neon green. (Completely unrelated: my first
car was neon green. And | had matching sunglasses.)

+ It employs Excel’s pretty horrible 3-D effect, which
can be tougher to interpret and look more amateur
than 2-D charts.

CHAPTER 3 - DESIGN WITH ELEGANCE

+ There's no need for the axis labels because the values
were brought into the columns using data labels.

+ There's no need for gridlines for the same reason
as above—especially not unnecessarily thick (and
dark) lines.

+ The border around the legend looks clunky.

+ The red arrow is poorly formatted and confusing. It
appears, fromthe preceding paragraph, it's supposed
to denote when the Merger Review Process initiative
was announced, but someone shouldn't need to read
a paragraph of text to figure out why an annotation is
on the chart. If it's not abundantly clear, there should
be an accompanying text box.

| have to say, although | was a bit aghast at the lack
of alignment with their powerful branding and basic
chart design principles, | was encouraged by just how
important these data visualization skills are. If the DOJ
is struggling with making their data sexy, it should
encourage you to see just how marketable these skills
will make you!

THE MAKEOVER

After accessing the DOJ’s branded colors and primary
font using Chrome Developer Tools, | transformed their
3-D chart in just under three minutes (Fig 3.4).

Fig 3.4: | transformed DOJ’s 3-D chart using Excel’s built-in styles and
its colors and fonts.

U QI GIHNOINY See the Steps to Creating a Tem-

plate section of the Set It and Forget It chapter to find
a brand'’s main fonts and colors.
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Truth be told, | cheated on the background by using Excel’s
built-in chart styles (Chart Design » Style 9). Shh.

| rarely use background colors for charts, especially
ones with gradients, but it was a good opportunity
to point out that you can use Excel’s chart styles for
inspiration, if nothing else. However, many of them
are littered with chart junk, so proceed with caution.
In reality though, the chart | would more typically
create would be void of background color (Fig 3.5).

Fig 3.5: What the chart would look like with no background color.

| won't be using them in any of the visualizations in
the Create Charts chapter. We'll build everything from
scratch. Like how | used to make cookies until they
came out with tubs of chocolate chip cookie dough.

Annnd | just lost my focus and am jonesing for cook-
ies now....

For the second visualization (seriously, who uses data
tables?), | built a few alternatives (Fig 3.6).

The first one incorporates a mean line. Take note its
subtlety compared to the one on the DOJ site. | also
brought the data into the columns and bars to satisfy
their lust for data tables.

U JHIGIWYOINY See the Diverging Bar Chart and

Diverging Stacked Bar Chart tutorials to learn how.
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The second chart took 12 minutes because it was a
little more customized. But a diverging bar chart can be
a great way to visualize metrics that are oppositional
in nature. Sometimes recipients will spend more time
digesting your data because they’re mesmerized by
the creativity of the presentation. And then they’ll start
wondering if they're paying you enough to prevent a
competitor from poaching you.

But | digress.

Fig 3.6: These are just a few streamlined alternatives to their line chart.



The last chart took me 40 minutes to figure out because
it's super hacked. Excel doesn't give you the ability to
position your data labels in between your diverging
bar charts. And it really doesn’t want to. | wanted to
include a tutorial on how | accomplished this hack, but
the labels need to be identical in length in order for it
to work (e.g., Q1, Q2, etc or years), so the uses cases
were too limited to justify the tutorial.

The moral of this story: Don't be a cautionary tale.

BE LIKE CHEVRON

Disclosure: | have no affiliation with Chevron, and
they've never been a client. But | could hug the analyst
responsible for branding their visualizations. Clearly a
kindred spirit.

All  the charts and Vvisualizations | found on
chevron.com reflected Chevron's branding. They were
also elegant and relatively clutter free. When you're
publishing your data publicly, you can't assume viewers
have any kind of backstory. Consequently, annotations
are key, and they use them effectively.

I'm not saying that they're perfect or that | endorse
all their design choices. If we're being picky, there is a
change I'd recommend for each of the charts:

+ Sort the data before creating a donut chart from it
(Fig 3.7).

Fig 3.7: Id sort the data first.
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+ Use a stacked bar chart over a stacked column chart
because of the longer labels. | don't like making
viewers tilt their heads to read labels (Fig 3.8).

Fig 3.8: I'd use stacked bar charts.

+ Youdon'talways need a vertical axis or gridlines with
a line chart (Fig 3.9). If the chart is simple, you can
use markers with data labels embedded in them to
pull the data into the line, as you'll see with Add
Sizzle variation of the Line Chart tutorial (Fig 3.10).

Fig 3.9: I'd use data labels over an axis.

Fig 3.10: This chart would allow them to ditch the
y axis and gridlines—and highlight actual values.
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+ Use a thinner target line (Fig 3.11).

That said, they're still a far cry from the DOJ'’s visualizations.

Fig 3.11: I'd user a thinner target line.

HOW TO ANALYZE AN
ORGANIZATION’'S BRANDING

When I'm analyzing a new client’s branding | look a
few places:

+ Their Homepage: Most organizations put their best
foot forward on their homepage of their website.
| look at their accent colors and compare them to the
logo. If your client is Google, finding their branded
colors couldn't be easier. But you don't usually get
quite that lucky.

+ Google Images: I'll use Google Images specifically
to search for images of charts and other visualiza-
tions. You can use a custom query to search only
the chevron.com domain for images about charts
or data (Fig 3.12).

Fig 3.12: Searching Google Images is a great way to see if a site has published any of its charts.
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+ Press Kit: Most larger organizations have some
kind of press kit they make available to jour
nalists, and it's usually accessible from their
About page. | simply search Google and restrict
my search to that domain, e.g., [press kit site:
chevron.com]. If the site doesn't have a press kit
per se, they usually have some kind of downloadable
file. Organizations put a lot of effort into these kits,
so you should find the best representation of
their branding.

+ Investor Presentations: Same as the press Kkit.

+ Downloadable PDFs: Search Google, restricting
your query to the organization’s domain, but add
[filetype:pdf] (without the square brackets) to your
query. In this case, you don't need any keywords.
You could search instead, for example, [filetype:pdf
site:chevron.com]. Again, organizations usually
brand PDFs they make available for download.

Okay, story time is over. Let's jump into some key tech-
nigues you'll come across in the Create Charts chapter.

HOW TO SUMMON
FORMATTING OPTIONS

Since we'll be focusing on formatting options
throughout this chapter, this is as good a time as
any to share a formatting tip | use frequently. By
frequently, | actually mean in every visualization

| create, without exception.

[t's Command-1. It's the key to the formatting kingdom.
Whatever you select in a chart element, pressing
Command-1 will open the formatting options.

Microsoft has been moving away from pop-up dialogs
in preference of a formatting pane that will open along
the right edge of your workbook. You'll still come across
some dialogs as you wend through the tutorials in the
book, but over time it will probably become like finding
a Rhode Island license plate out in the wild.
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ALTERNATIVES TO KEYBOARD SHORTCUT
You have three alternatives to using the Command-1
keyboard shortcut:

+ Right-click:Right-click and choose Format[element
you right-clicked on]. This is a reliable alternative,
but sometimes | move the mouse when | right-click,
causing me to misfire. Plus, | don't like wasting time
looking for the format option in the contextual menu.
But if you're a right-clicking superstar, go for it!

+ Double-click: Double-clicking on a chart element
will oftentimes summon the corresponding format-
ting pane. However, at the time of writing, this tech-
nique doesn’t work for data in cells or with objects,
such as shapes or icons.

+ Ribbon: When you select a chart element, you'll
oftentimes see an additional menu appear in the
menu (e.g., the Chart Design or Format tabs).

ONE AND YOU'RE DONE

The first time you select a chart element to format it,
you will need to open the formatting options using the
keyboard shortcut or an alternative. Once the format-
ting pane (titled Format [Element You Selected]) is
open, however, it will update whenever you select a
new element in your chart.

Sometimes | forget about that workflow saver and press
Command-1 when | need to format a new element. It
will update the format pane so no harm no foul. Over
time you'll get more comfortable with just selecting a
new element and looking eastward.

NOT JUST FOR CHARTS

Command-1 doesn't just work in charts; it works with
whatever you have selected. For example, if you select
a cell or range of cells, you'll trigger the Format Cells
dialog (no formatting pane for you, cells); if you're in a
pivot table, you'll trigger pivot table formatting options; if
you've selected a shape, you'll trigger the Format Shape
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pane. You get the idea. You can also get to formatting
options through the contextual menu (by right-clicking).
| just have a strong preference for Command-1 because
of its efficiency, so that's what I'll use throughout the
tutorials in this book.

Warning: With shapes, an Excel engineer went rogue
and required that you give the Shift key playtime to
trigger the Format Shape pane (so Command-Shift-1).
Someone needs to get that fly out of the ointment. If
Command-1 doesn't work, | just right-click and move
on with my life.

TIP FOR HARD-TO-REACH
CHART ELEMENTS

There are times when you may have a difficult time
selecting chart elements. This might be because you've
added a data series with a percentage (decimal)
vis-a-vis a data series with whole numbers (e.g.,
website revenue vs. conversion rate or home sales
vs. interest rates). When your data series is hugging
the bottom of the ocean floor, it can difficult to select.

If this happens to you, click anywhere inside your chart.
It can even be in the Chart Area. Open the Format

tab and navigate to the Chart Elements drop-down
menu in the far-left edge of the menu. The visible
item will be the chart element you clicked. Click the
down-facing arrow to see all your chart elements and
click to select one (Fig 3.13).

| wish | had known about this tip earlier in my career
as an analyst. It would have saved me some time and
frustration zooming in on my data series until | could
finally grab the elusive little sucker.

KEY FORMATTING TECHNIQUES

OVERALL AESTHETICS

Stick to Branded Colors

| can't underscore this point enough. Every time | see a
website with a gorgeous color scheme publish visual-
izations with Excel’s [hideous] default colors, a piece of
me dies inside. It's exhausting.

| can hear your protests now: “Annie, my site only has
three branded colors, but my visualization has seven
categories...It takes a lot of time to manually change

Fig 3.13: Take advantage of the Chart Elements menu to select hard-to-grab elements.
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the colors in each of my charts...I don't know the hexa-
decimal values for my branded colors...| don't even
know what an hexadecimal value is...."

Well, for one, if your site's palette doesn’t include gray,
you can throw that in. You'll need gray if you're building
elegant visualizations, in my opinion. If you still need
more, | highly recommend using tints of your branded
colors over foreign colors. Tints are the colors that result
from adding white.

Aside: Shades are the colors that result from adding
black, but | work more with tints than shades in building
visualizations. As always, you do you!

Note: In this book, if | refer to blue, orange, or gray, I'm
referring specifically to my branded colors. | never use
colors outside the branded palette | used for the book.

Create Tints and Shades

Excel gives you the ability to create tints and shades
with a slider in its Colors dialog that you can get to in
a myriad of ways in Excel. Drag that slider to the left,
and you create a tint; drag it to the right and you create
a shade (Fig 3.14).

Fig 3.14: Drag slider to create tints
and shades.
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| rarely use this option because I'm a stickler when it
comes to precision and consistency, and | don't like that
you can't titrate white or black into your color with greater
specificity. | wish you could enter percentages. But since
you can't, I'll outline a few options you can choose from.

First of all, to get to the Colors dialog, select
More Colors from whatever pane or dialog you're
in (Fig 3.15). Excel gives you five tabs of color options
to choose from (Fig 3.16).

Fig 3.15: Select More Colors from
any color picker button.

Fig 3.16: You have five tabs of color
options to choose from.
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Three Approaches

THE RESPONSIBLE (ADULT) OPTION

One great tool that gives you the tint values
of your branded colors is the Hex Color Tool at
hexcolortool.com. To get started, either enter the
hexadecimal code associated with your color in the first
field under Enter a color or enter the RGB values into
the next field over (Fig 3.17).

Fig 3.17: Find tint values for your theme colors using hexcolortool.com.

Fig 3.18: This is my favorite way to find tint colors.
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If you only have the RGB values for your color, replace
the RG and B values in the RGBA field. At the time of
writing it's unlabeled, but the persistent tooltip inside
the field reads ‘rgba(x, y, z, 1). Replace x with your R
value, y with your G value, and z with your B value.
Leave the last parameter set to 1.

Tip: Only use the text boxes to the right of the sliders
if you have HSL values. | kept trying to enter my RGB
values and banged my head against that wall for a while
before | figured that out.

Set what percent you want to lighten your branded color
by using the drop-down menu and click the Lighten
button. You'll see your tints to the right (Fig 3.18). You can
see examples from the dark blue color used in this book.

| really like how the tool gives you both the hexadecimal
and RGB values for each of the colors. Rinse and repeat
for each of your branded colors. Store these some-
where because you'll need them for quick reference.

Excel for Mac allows you to use hexadecimal values,
which is the only advantage I've found to the Mac version
over the PC version...Well, that and Mac users can
choose colors using crayons with colors like Bubblegum,
which is a big hit among Excel users under the age of 10,
I'm sure. So you can use RGB or hexadecimal values.

If you feel more comfortable using RGB values, drop-
ping a hexadecimal value into Google (don't forget the #)
will usually return the RGB values for that color. What a
time to be alive!

MANUALLY ADJUST RGB VALUES

When finding incrementally lighter (or darker) colors to
complement your branded palette, you can increment
(or decrement) each of your RGB values by the same
amount. For example, the orange | use for the visual-
izations in this book has the RGB value of 238, 132, 52.
If I wanted to make it lighter, | could add 10 to each of
those values, giving me an RGB value of 248, 142, 62.
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Fig 3.19: Adding transparency is a pauper’s tint generator.

And if | wanted to make it darker, | could subtract 10
from each of those values, giving me an RGB value of
228, 122, 42.

THE KINDA NINJA (LAZY) OPTION

| probably shouldnt open myself up to scrutiny over
this hack. Discretion is the better part of valor and
all that. But sometimes it's not worth creating a full
palette of colors to choose from, especially if you just
need to create a tint or shade for an ad hoc chart (i.e.,
one you'll only use once and won't be templatized). In
those cases, | create a poor man's palette on the fly by
applying transparency to my branded colors using the
same amount each time (Fig 3.19). | have an affinity for
adding transparency in 8-15% intervals. Ymmv.

Whatever amount you choose, you should keep it the
same for each color. Any time you have the option to
add a fill color—whether to a chart element, shape,
symbol, etc.—you have the option to add transparency.
If your object is against a white background (which they
are by default), you're adding white to your color.

| know, mind blown, right?
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Warning: If anyone ever decides to throw your chart
against a formatted background, your shenanigans will
come to light. If that's a risk you can live with, go for it!
With the skills you'll learn in this book, you should have
no problem finding another job!

Design for Colorblind Users

According to the National Eye Institute, the most
common type of hereditary color blindness is
red-green. Also, men are more likely to be colorblind
than women because the genes responsible for the
most common, inherited color blindness are on the X
chromosome. And since we chicks have twice as many
X chromosomes (HOLLAH!), we're infinitely more
qualified to decide if your tie clashes with your socks.
(Okay, | might be taking liberties.) Learn more about
what researchers actually said about color blindness
here: bit.ly/mdsem-color-blindness.

Where the pinch comes in is many cultures use greens
and reds to express positive and negative metrics,
respectively. You will need to decide, as an organiza-
tion, how your chart designs will comply with usability
best practices.
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Fig 3.20: It’s clear that the orange bars indicate negative metrics by their position and the data labels.

Similarly, | use position and
tints to indicate different levels
of positive and negative survey
responses (Fig 3.21).

To see how people with differ
ent types of color blindness
would see your visualization,
you can use a tool like the Coblis
Colorblindness Simulator (avail-
able at bit.ly/mdsem-cb-test).
Just take a screenshot of your
chart and upload it. You might be
surprised by what you see!

Point Out

Actionable Insights
Storytelling with data is all the
rage. When you're using data
to tell a story, your chart title
serves as a headline of sorts.
The rule | follow, in general, is
if I'm doing ad hoc analysis, |
gravitate more toward head-

Fig 3.21: 1 didn’t need to use red and green to indicate positive and negative survey responses.

I'm not a fan of using red and green in charts (unless
they're your branded colors) and don’t use them in any
of the visualizations in this book. | restrict all my colors
to the three branded colors in my palette. Instead,
| rely on positioning, data labels, annotations, and chart
titles to express negative metrics. For example, in the
Baseline Delta Chart tutorial, you'll see that you can use
positioning of your negative columns and data labels to
clearly communicate negative values. | even custom-

ized the number formatting of the data labels to remove
the negative signs (Fig 3.20).

(- JTHIGIWYD]NY See the Customize Number Format-
ting section of this chapter to learn how to customize

your number formats.
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line-esque titles, e.g., "Social

Traffic is En Fuego” or “Sales
in the Southeastern Region Have Stalled.” Then I'll use
a subtitle to indicate what I'm charting.

However, if I'm building out a dashboard—especially
one that updates automatically using an API connec-
tion—I tend to flip that approach on its axis (data analo-
gies for days!) and use the title to indicate what's being
charted and a subtitle or text box to tell the story. This
is just my approach. Over time, you will need to figure
out what works for you.

The important takeaway is that you always point out
what you want your viewers to take away from the
visualization. You might think it's glaringly obvious, but
you've been all up in the data. Your viewers haven't.
Therefore, be cognizant of that and err on the side of
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Customize Number
Formatting

There are times in this book
you will need to use custom
number formatting. You can
access number formatting
options by selecting a value in
a cell(s) or chart element (e.g.,
data label or axis) and pressing
Command-1. Excel's custom
number formatting options are
robust, and we'll barely scratch

the surface in this book.

Fig 3.22: Link to other cells/worksheets to make your document easy to navigate.

over-communication, even if these insights are extracted
and published in a separate worksheet. | recommend
linking to the visualization you reference if you tease
out findings in a separate worksheet. To link to another
worksheet in your workbook, take the following steps:
press Ctrl-K » select This Document in the Insert
Hyperlink dialog > select your target worksheet from
the preview window and/or type in your cell reference
(or navigate to the cell you want to link to and select it)
» click OK to close the dialog (Fig 3.22).

Fig 3.23: From L to R: positive, negative, and 0 formatting.

The main thing to keep in
mind is that Excel separates each of the codes with
semicolons (Fig 3.23). The first set of code determines
the formatting for positive numbers (red outline), the
second set determines the formatting for negative
numbers (gray outline), and the third set determines
the formatting for O (black outline).

The simplest way to customize number formatting is to
tweak the code Excel generates, as we'll see in exam-
ples later in this section.

Use Cases

Working with Accounting Number Format

| use Excel’'s accounting number format quite a bit
because revenue is oftentimes the bottom-line metric
organizations care most about. But there are a few
customizations you'll see in this book:

+ Remove decimals: In my line of work, I'm usually
working with revenue data that's aggregated. So,
when dealing with large revenue amounts, the
decimals are unnecessary and hence become
noise. | remove them using the Decrease Decimal
button under Home (last one on the right).

+ Replace hyphen with 0: Excel's default accounting
number format uses hyphens for the value 0. So,
instead of a 0 in the bottom-left corner of a chart,
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you'll see a hyphen, which | really don't like. It
reminds me of the "Which one of these is not like
the others” game on Sesame Street. | always pull
up the formatting options and change the hyphen to
a 0. The easiest way to switch them out is to apply
the number format you want from the number
formatting buttons under the Home tab, then press
Command-1 to open the Format Cells dialog.
Under the Number tab, set Category to Custom
and carefully select "="?2 in the 0 formatting code
(i.e., after the second semicolon) and replace it with
a 0 (Fig 3.24). Be careful not to remove the space
before the first quotation mark, or your O won't align
with your positive and negative values.

Fig 3.24: Evict those unsightly hyphens without notice, if
you're charting accounting data.

+ Remove negative formatting: You'll see an example
of where | do this in the Baseline Delta Chart tutorial.

+ Assign special formatting: Although we don't use
this strategy in the book because it falls more
under data entry, you could format numbers like
social security numbers (in the U.S.) or product
IDs. For social security numbers, you would set
it to ###-##-##44# This way, if a user needs to
enter a column of social security numbers, he
won't need to include the hyphens.
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Adding a Thousands Separator

| use thousands separators (essentially, commas for
numbers) for any numbers > 999. But | also tuck in
most blouses, blow dry cold necklaces, and fluff my
pillows before | can use them. So there's that.

Some [wrong] people eschew thousands separators
until they hit five digits. But whatever you decide for
yourself, when you need them, you can access the
Comma Style button under the Home tab. This style
adds sophisticated custom number formatting code
that helps your numbers align. If I'm not working with
currency (which uses the same highly customized
formatting, only with currency symbols), I'll frequently
apply this formatting just to trigger these finessed
formatting options, then go in and customize it to take
it the rest of the way.

Warning: Applying the thousands separator also
switches out Os for hyphens, so if you prefer a 0 over
a hyphen, you'll need to customize the format, as
demonstrated in the previous section.

Working with a TEXT function

We will also use custom number formatting code inside
TEXT functions to trick out our visualizations with chart
elements, such as chart titles and annotations that
update dynamically—as you'll see in the Bar Chart tuto-
rial—or reference a cell containing text and a calculated
value—as you'll see in the Scatter Plot tutorial, where
we pull the correlation coefficient into our chart.

Simplify Large Numbers

Having very large numbers in a chart axis can make the
axis cumbersome, so I'll oftentimes express values in
thousands or millions. To do this, first apply the thou-
sands separator to format your data, then take the
steps below, depending on your values.

Alternatively, you can use the Display units feature in
the Format Axis pane to indicate that you've simplified
larger numbers in your axis (Fig 3.25).



Thousands

If you want to simplify thousands, you would carefully
remove the highlighted sections from the Type field
(#40): (Fig 3.26).

| also customed the code for O by replacing "-"7?7?
with 0. If you're working with currency, you would

Fig 3.25: You can also use the Display units feature to simplify larger numbers.
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first apply accounting number formatting to your
data, then take the same steps. The accompanying
screenshot shows what it would look like when
you're finished (Fig 3.27).

And if you want a decimal place, don’t remove the deci-
mals before customizing your number formatting.

You can see an example of simplifying
thousands values in the Line Chart tutorial
(Fig 3.28).

Fig 3.26: Simplify large numbers using the format code.

Fig 3.28: Axis labels are shown in thousands with an axis title indicating the truncation.

Fig 3.27: Customize number formatting to simplify
currency values.
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Millions

If you want to express numbers in millions, simply add
another comma. This will make your first comma sliiide
to the left (Fig 3.29).

If you simplify large numbers in your axis, be sure to
communicate that somewhere in the chart. A few
options you have are in the chart title (if the title isn't
too long), a subtitle, a text box, or an axis label.

Fig 3.29: Throw in an extra comma to simplify by millions.

Fig 3.30: Values in data labels are simplified to millions.
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You can see an example of simplifying millions values in
the Lollipop Graph tutorial (Fig 3.30).

Reformat Negative Numbers

There are times you'll use negative values to position
your data to the left of the vertical axis, as you'll see
in the Diverging Bar Chart tutorial. To do this, you'll
just make sure the code for negative numbers (after
the first semicolon) matches the code for positive
numbers. This usually means removing parentheses
or the negative sign.

Fix Alignment

| don't know about you, but when | was a kid we would
randomly pretend that certain areas of the playground—
usually under the jungle gym—were filled with lava.
Unless you wanted to be screamed at by a mob of kids
doped up on sugar-laden school lunches, it was in your
best interest to avoid these pop-up lava pits.

Where am | going with this?

The first time | added numbers to data labels to mark-
ers in a chart, | was perplexed by the alignment and
would wonder to myself, Why does it look like the left
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GO LEARN MORE See
the Customize Number
Formatting section of
this chapter to learn how
to customize your num-

ber formats.

Fig 3.31: Your number formatting may push the numbers in the data labels a hair to the right of center.

side of the marker is a lava pit from years gone by? (But I didn't have any 0 values in the example file.)
It was because positive numbers were coded to

include a space to the left of the number (Fig 3.31).

Alternatively, you could simplify your code to what you
know you'll need, which is what | did to clean up the

The (" at the very front of the number code is the data labels referenced above (Fig 3.33). | used:

drama queen. The underscore tells Excel to leave a 0.0:-0.0;0

space the width of whatever character
comes after it—in our case, a parenthesis.
This allows positive numbers to line up
with negative numbers that are formatted
with parentheses.

To resolve this issue, select your data
labels by clicking one of them, then press
Command-1 to open the Format Data
Labels pane. Next, open the Label Options
tab. Under Number, deselect Linked
to source, which will reveal the number
formatting code in the Format Code field.

You can delete the offending underscore-pa-
renthesis team, and add your custom code
into the Type field by clicking the Add
button. For charts with both positive and
negative values in your data labels, you'll
need to remove this dynamic duo for both
positive and negative values. | included the
0 number formatting in the accompanying
screenshot to cover all my bases (Fig 3.32).

Fig 3.32: Removing the “_(”
in the number code may fix
the funky alignment.

Fig 3.33: You can also simplify your
number formatting to realign text.
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Colorize Icons

If you use an icon from Excel (as you'll see in
the Pictograph tutorial), you can change its color
several ways:

+ Open the Format Graphic pane and choose one
of your theme colors from the Fill/Outline Color
button (Fig 3.34). (They're in the top row.)

Fig 3.34: First option to recolor an icon.

Fig 3.35: Second option to recolor an icon.
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+ Navigate to Graphic Format » Graphics Fill
(Fig 3.35).

+ Select one of the presets Excel creates from your
theme under the Graphic Format menu (Fig 3.36).

If you're using a theme—which you'll learn how to
create in the Set It and Forget It chapter—you can (and
should) change it to one of your theme colors (Fig 3.37).

Fig 3.36: Third option to recolor an icon.

Fig 3.37: Recolor icons using your branded colors.



Fig 3.38: Recolor images to align them with your branding.

Warning: Command-1 won’t open the Format
Graphic pane. Hopefully the Microsoft team will fix
this eventually. You'll need to right-click on the icon
or graphic and choose Format Graphic from the
contextual menu or select Format Pane from the
Graphic Format tab.

L JHIGIWYD]NY See the Stick to Branded Colors
section of this chapter to learn about the importance of
restricting your design choices to your branded colors.

If you're using an image from elsewhere (as you'll see
in the Dumbbell Plot tutorial), you can change its color
to align with your branding. First, select the image, then
and navigate to Picture Format » Color » Recolor to
choose a recoloring option. Alternatively, you can either
adjust the saturation or tone. | usually choose the
recolor option (Fig 3.38).
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Fig 3.39: Additional settings are avail-
able in the Format Picture pane.

If you're not using a monochromatic image (your lust
for color may be your undoing!), you may need to tinker
with more advanced settings, which you can get to
by selecting Picture Color Options from the bottom
of the Color drop-down menu, which will open the
Format Picture pane (Fig 3.39).

Paint Formats

Sometimes you go to great lengths to format your data,
just to do it all over again for another dataset. A great
tool | use all the time is Excel’'s Format Painter. You can
access it by navigating to Home » Format. (It's the
paintbrush icon in the first section of tools. Excel for
Mac doesn’t have labels for these sections like you get
in the PC version. *sigh*)

If you select one cell, Excel will use that cell's format-
ting to paint another cell or range of cells. If you select
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several columns of data with a variety of formats
(number, fill, border, conditional formatting, etc.) and
paint over a range of cells with the same number of
columns (or rows), Excel will apply the formatting from
the first dataset’s columns to the second dataset.

You can also use the Format Painter to copy column
and row widths. To do this, select the column or row
heading, click the Format Painter and apply to another
column(s) or row(s).

Warning: If you use the Format Painter to set column
width or row height, Excel will apply any other formatting
that was applied to the column/row you sampled. For
this reason, I'll usually only sample blank columns/rows.
If you need to sample a column that is formatted, you'll
want to use the Paste Special option.

U JIIVIWMND]NY See the Copy Column Widths

section of this chapter to learn how to replicate
column widths.

Finally, double-clicking the Format Painter will allow
you to use it more than once. When you're finished,
click the Format Painter again or press the Esc key to
send it back into retirement.

Where this can be especially handy is with visualiza-
tions that require advanced formatting, such as the
heatmap, which you'll see in the Heatmap tutorial.
Because a heatmap is a table and not a chart, you
can't save it as a chart template. However, you can
save it in your workbook of visualizations you can't
save as templates, then apply its formatting to a
new dataset with similar data, saving you a signifi-
cant amount of time. And the Format Painter works
across workbooks, meaning you can load it up with
formats from one workbook, switch to another work-
book, and apply your formatting.
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CHART AESTHETICS

Add Data Labels

In my quest to minimalize clutter, I'm always looking
for the opportunity to get rid of as many elements in
my charts as possible. One of the top elements on my
radar is the value axis. The best way to eliminate the
need for the value axis is to bring your values into the
chart via data labels.

How to Add

To add data labels, select a data series or data point
and navigate to Chart Design » Add Chart Element »
Data Labels » More Data Label Options, which will
open the Format Data Labels pane. Under the Label
Options tab, you'll be able to set what you want
to appear in your data labels under Label Contains
and your data labels’ position under (wait for it....)
Label Position.

If you don't want your data labels to appear outside
the bars—Iike they locked their keys in the car and
are locked out until AAA shows up—set them to
Inside End. You might need to change the text color
to white to make them pop. That's my go-to setting
for most charts.

If I'm adding them to markers, I'll typically make the
marker bigger and set Label Position to Center.
You can see examples of these in the Line Chart and
Dumbbell Plot tutorials.

Making Room

If you're working with columns or bars and they're not
wide enough to accommodate your labels, you can
fatten them up. You'll learn how in the Adjust Chart
Series Spacing section in this chapter.

You also have the option to customize the number
formatting of your data labels in the Number section
under the Label Options tab of the Format Data
Labels pane. To customize, enter your code in the
Format Code field and click the Add button below.



- JITCIMND]NY See the Customize Number Format-

ting section of this chapter to learn how to finesse your

number formatting.

After you set the formatting for one series, you don't
need to continue doing this. When you apply it to
another data series, you can set Category to Custom.
Then you will see your custom code in the Type drop-
down menu. Simply select it to apply it. You can see
an example of using custom number formatting in the
Dumbbell Plot tutorial (Fig 3.40).

Reassign Values
Sometimes you might need to point a data label to a
different cell in your data.

Fig 3.40: Choose your custom
number formatting from the
Type drop-down menu.
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This is easier to do on a PC because in the Label
Options tab, under Label Options, you have the
option to select Value from Cells. Then you just click
the Select Range button and click-and-drag over the
data you want to use. Excel for Mac doesn't offer
that feature.

Hopefully the Excel for Mac team wiill bring that feature
to the Mac version one day. But until then, what you
need to do is select each data label individually and
point it to the new cell with a formula. In the accom-
panying screenshot, | selected the data label (make
sure it's surrounded by white boxes, not blue circles),
entered an = in the Formula Bar, selected cell C41,
then pressed Return to finalize the deal (Fig 3.41). The
data label updated to 74,113.

Fig 3.41: It’s a manual process, but you can switch out the values in your data labels.
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Fig 3.42: You can (and should) either delete or significantly lighten gridlines in your charts.

Ditch Gridlines

You don't need gridlines in your worksheets, especially
if you format your raw datasets as tables. To rid your
worksheets of them, select any cell in your worksheet,
then navigate to View and deselect Gridlines.

U JHIGIWYO]Y See the Formatted Tables section of
the Massage Your Data chapter to learn how to cus-
tomize Excel’s tables to meet your needs and branding.

In charts, you can select them by selecting one of them,
then either press the Delete key on your keyboard
or lighten them by pressing Command-1 and either
increasing Transparency or setting Outline color to
a lighter color in the Format Major Gridlines pane
(Fig 3.42).

Modify Chart Title

Excel will pull the metric you're charting into your chart
title, but a sole metric is rarely adequate. You want your
chart title to be descriptive. You may also want to add
a subtitle or annotation with more info about the data
source, methodology, etc.

You can also create a title that dynamically updates
with new info, such as the current month. To do this,
you need to create a formula in a cell that concatenates
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(i.e., glues together) the different
pieces that willbecome your title.
These formulas can get compli-
cated fast, but you can use helper
cells to build your title piece
by piece and then stitch them
together in a cell with your final
formula. Learn more about using
helper columns in my post on
the Search Engine Land website:
bit.ly/mdsem-helper-columns.

When combining text and a value
that updatesin a cell, you'll usually
need to wrap the value reference
in a TEXT function. The TEXT function lets you change
the way a number appears by applying formatting to it
with number format codes (Fig 3.43).

Fig 3.43: Create dynamic title with the TEXT function.

Fig 3.44: White space is your friend.


http://bit.ly/mdsem-helper-columns

When you're finished formulating your chart title in your
helper cell, select your chart title chart element, then
enter an equal sign in the Formula Bar and select the
helper cell to link them.

Give Chart Title Space

| personally don't like how Excel’s default format is to
have the chart title hug the top boundary of the Plot
Area in a chart. | like to add a little of white space. If you
want to add white space, click inside the Plot Area and
drag the sizing handle along the top of the Plot Area
down a bit (Fig 3.44).

Add Annotations

You can add additional information, such as source for
your data, methodology, observations, and even addi-
tional data by inserting a text box.

How to Add

To add a text box to your chart, click anywhere inside the
Chart Area and navigate to Insert » Text Box. Drag
toward the bottom-right corner of your worksheet until
it's about the size you need. You may need to make room
for your text box it by selecting the Chart Area and/or
Plot Area and dragging the sizing handles to taste.

Fig 3.45: These settings ensure text centers in your text box.
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Formatting Text Boxes

The default formatting of text boxes is pretty clunky.
There are a few steps | recommend taking before
taking them out in public. To open the formatting
options for a text box, select it, then navigate to the
Shape Format tab or press Command-1 to open the
Format Shape pane.

Tip: If the Format Shape pane doesn’t open when
you press Command-1 (Excel can be temperamental),
select Format Pane under the Shape Format tab
to open it.

Fix Funky Margins

To adjust the settings, with the outside edge of your
text box still selected, select Format Pane from
the Shape Format tab. This will open the Format
Shape pane. Open the Size & Properties tab, and
in the Text Box section, select Resize shape to fit
text. This will ensure your text doesn't break the
boundaries of your text box (and should be the default
setting, in my opinion). Next, set Top margin and
Bottom margin to .1 to match the Left margin and
Right margin (Fig 3.45). These options, when used
in concert, ensure that your text will be centered in
the text box.
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Format Border

The default text box border is unremarkable. Experiment
with different settings in the Format Shape pane
(Fig 3.46). | formatted the text boxes in the book using
the following settings under Fill & Line:

+ Line: Solid line
+ Color: blue
+ Width: 2.25 pt

+ Dash type: Round Dot

Fig 3.46: Soup up your text box with some boujee borders.

Fig 3.47: Add a subtle drop
shadow to your text box to
create a sense of depth.
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| also added a drop shadow to give my text box a little
depth.To do this, open the Effects tab. Under Shadow,
set Presets to your choice (Fig 3.47). | used Outer »
Offset: Bottom Right (the first option). Or you can
customize your shadow options using the Color, Trans-
parency, Size, Blur, Angle, and Distance settings.

Set Default Text Box Formatting

If you want to reuse your text box, you can set it to be
your default text box by right-clicking on it and choosing
Set as Default Text Box from the contextual menu

Fig 3.48: You can set your formatted text box as the default text box.



(Fig 3.48). The super bummer is that this will only set the
text box as the default for that file. But we'll fix that with
the mother of all Excel hacks.

L JIIVIRYDINY See the Templatize Everything sec-

tion of the Set It and Forget It chapter to learn how to
save time and effort with templates.

Pull in Values

Another cool thing you can do with text boxes is dynam-
ically pull in text or a value that resides in a cell. To do
this, select the text box, then enter an equal sign in the
Formula Bar, select the cell with the text or value you
want to pull in, then press Enter to activate the formula
(Fig 3.49).

Fig 3.49: Use a formula to pull text or a value from a cell into a text box.

If you want to combine values and text, you'll need to
stitch everything together in a cell in your worksheet.
First, enclose text in quotation marks. Then enter an
ampersand (&). Finally, wrap the cell that contains the
value you want to include inside a TEXT function. You
will need to include the number formatting code in the
function.

For example, in the Scatter Plot tutorial, | dropped the
following formula into cell E5:

="r = “&TEXT(E4,70.00")

A few notes about this technique:

+ If you specify only one section of format code—
as | do in the above example—the code is used for
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all numbers. Negative numbers, in this case, will
use the negative sign (as you'll see in the Scatter
Plot tutorial).

If you specify two sections of format code, the first
section of code is used for positive numbers and
zeros, and the second section of code is used for
negative numbers.

When you skip code sections in your number
format, you must include a semicolon for each of
the missing sections of code.

If you forget which function you need to pull both
text and a calculated value into a text box, just think
TEXT function, text box...You won't be judging my
silly mnemonic devices when you realize the Google
searches | just saved you the first three or so times
you try to do this!

Any text needs to be wrapped in quotation marks.
Remember to add in spaces so the value generated
from your TEXT function doesn't get too awkward
with your text. This makes perfect sense until you
go to concatenate. Imagine my gloatiest “toldja”
face when it happens

You use an ampersand (&) to join text with calcu-
lated values.

In cell E4, I've used the CORR function to calculate
the correlation coefficient for my dataset:

=CORREL(B4:B253,C4:C253)

Even if | restrict my value to two decimal places in
E4, unless | use the TEXT function, Excel will pull in
the full value (Fig 3.50).

Fig 3.50: Whoa. At ease, Excel.

57



CHAPTER 3 - DESIGN WITH ELEGANCE

Fig 3.51: Use a function to dynamically pull content into a text box.

+ Remember to wrap your number formatting in
quotation marks. | forget to do this more than
| remember. #dontjudge

+ Remember to add any symbols you need inside
your number formatting, e.g., currency, thousands
separator, percentage sign, etc.

+ To embed your text box in your chart so that it
moves and resizes with it, you need to select your
chart before drawing it. If you just draw it on top of
your chart without selecting it or create it outside
your chart and drag it in, your text box will not be
embedded. It will sit in a layer on top of your chart.
This isn't ideal. If you created your text box outside
your chart, you'll need to cut it, select your chart,
and paste it in. Excel will drop it in the upper-left
corner of the Chart Area. Just drag it where you
want it.

+ To pull your final value into your chart, first draw
your text box inside your chart. Next, select it by
clicking its border, then enter an = sign into the
Formula Bar and select the cell that contains
your TEXT function. When you press Enter, it will
appear in your text box (Fig 3.51). Then you can
format it to taste.
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L JHIGIWYD]H See the Customize Number Format-
ting section of this chapter to learn how to finesse your
number formatting.

Add Border to Touching Data Series

With some charts, such as any of the stacked charts
or the pie chart, your series may touch. Sometimes
Excel is cool and automatically adds a border between
series. You'll see that in the Pie Chart, Donut Chart,

Histogram, and Pareto Chart tutorials. But other times,
Excel is asleep and lets the series touch. And some-
times when they touch, the honesty's too much. Lulz.
#productofthe70s

| like the extra contrast the border adds, especially with
charts with many series, where you may be working
with tints of your branded colors, as you'll see in the
100% Stacked Area Chart tutorial (Fig 3.52).

To add a border to a data series, select the series and
press Command-1 to open the Format Data Series
pane (Fig 3.53). In the Fill & Line tab, set your border
parameters. | typically use the settings below:

+ Border: Solid line
+ Outline color: white

+ Width: .75 pt



Fig 3.52: Series borders add a touch of class to your charts.
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Fig 3.53: Use half the border line width you need because borders are additive.

Tip: When you apply the border to your first series,
it will look pretty lame. But when you apply the same
border to your next data series, you'll notice that
the width of the border will be doubled because the
borders are adjacent, not overlapping. Then your border
width should work—although feel free to tweak
and test!

Align Strategically

Just because Microsoft centers most everything by
default, this isnt necessarily the optimal choice. For
example, if you pull together a number of charts
together in a dashboard, it can be more visually
distracting to have chart titles floating all over the
place, which is how they look when they're centered
in each of your chart widgets.
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Anything can be moved, so don't be afraid to move
things around. To move the title, drag it to where you
want it. Hold down the Shift key to constrain movement
to a horizontal or vertical plane.

Align Options

We will use the Align menu quite a bit in tutorials
(Fig 3.54). You can access it from the Format tab of
whatever you're working

with. Some of the tab

titles you'll see are For

mat, Shape Format,

Graphic Format, and Pic-

ture Format. You can also

usually access it through

the contextual menu,

which you summon by

right-clicking on the ob-

ject you want to edit.
Fig 3.54: The Align menu is
helpful in adding finesse to
your visualizations.

To select objects to align them, you can hold down the
Shift or Command key.

Demystifying Align Options
The Align menu groups your options, but | find the
categories a bit confusing so I'll break them down:

+ Horizontal: If you have objects that are distributed
vertically, the options in this section are what you
need—even though it's categorized as Horizontal.
(See the pinch?) You can align them by their left
edges, centers, or right edges. If you're lining up
text boxes, left-aligning is the most reliable. If you
want to use one of the other options, you need to
ensure you don’t have excess space between your
text and the right edge of the text box because it
will be factored in and will throw off the alignment.

+ \ertical: Same as above, but they help you align
objects that are positioned horizontally.

Fig 3.55: Use the Distribute Horizontally option to ensure your faux axis is runway ready.
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+ Distribute:These options allow you distribute objects
equidistantly—either horizontally or vertically. You'll
see an example of how we use the Distribute
Horizontally option to mimic horizontal axis labels
in the Dot Plot tutorial (Fig 3.55).

Snap to Options

Snap to Grid

If you want to snap to the grid when you're moving
objects (charts, text boxes, shapes, etc.) you can enable
this option from the Align menu by selecting Snap to
Grid. Then items will automatically try to snap to the
grid as you drag them.

Alternatively, if you hold the Command key down while
you drag, Excel will snap your object to the grid. | actu-
ally prefer this method.

This shortcut also works when you're dragging sizing
handles, e.g., to line your chart’s edges up with Excel’s
grid and other charts. You don’t have to turn on grid-
lines for this to work. | don't even think about it. | just
Command-drag like a fool. But if you want to turn on
gridlines, you can do that by navigating to View »
Show » Gridlines.

Warning: It's one or the other. Commmand-dragging won't
work if you've enabled Snap to Grid.

Fig 3.56: Use the count value from the Status Bar to calculate the length
of a data range.
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My typical workflow is to snap the upper-left corner of
the chart to the grid, then Command-drag the bottom-
right corner of the chart to snap the right and bottom
borders to the grid (Fig 3.56).

Tip: If you want to make charts the same size, you can
drag over a range next to the chart to see how many
cells wide and/or long it is. If there's data in those cells,
you can look at Count in the Status Bar.

If there's no data in the cells, it's a little trickier but still
doable. Just click-and-drag over the range, but before
you let go of the mouse, take a gander at the Name
Box. It will tell you the number of columns and rows
in the active selection. It will take the form of rows x
columns (Fig 3.57).

Snap to Shape

There are times you can't just select the items you want
to align and use an option from the Align menu. In those
instances I'll drag out a shape—usually a very thin line—
and use Excel’s Snap to Shape feature to align my chart
elements. This is a helpful trick when aligning your chart
title with other text boxes, like a subtitle and/or text box
(as you'll see in most of the charts in this book). Aligning
data labels can be also problematic, as you'll see in the
Add aTarget Line variation of the Line Chart tutorial.

Fig 3.57: Use the Name Box to count empty cells.
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First, Shift-drag out a line (Insert » Shapes » Lines »
Line). Holding down the Shift key constrains the angle
of the line you're drawing to 45° angles, giving you
perfectly horizontal, perpendicular, or diagonal lines.
Then select the object you want to line up with your
line and turn on Snap to Shape by navigating to the
Format tab for that object (Format Shape, Picture
Format, etc.), then selecting Snap to Shape from the
Align menu (Fig 3.58). You'll see a checkmark next to
it when you enable it. (You'll need to reopen the Align
menu to see it.)

Fig 3.58: Turn on Snap to Shape if you need to
align objects to a common element.

Now drag your object toward the line until it snaps into
position. Rinse and repeat for each object. Once every-
thing is lined up, delete the line.

Warning: If you turn on Snap to Shape before you drag
out your line you might have a difficult time positioning
it where you want. Also, make sure Snap to Grid is
turned off.

Group to Preserve Your Work

Once you get everything aligned, | highly recommend
grouping your objects before you deselect them.
You can group by Shift- or Command-selecting the
items, then navigating to the format tab that appears
in the menu and selecting Group Objects » Group.
Alternatively, you can right-click on the selected objects
and choose Group » Group from the contextual menu.
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At the time of writing, with the [half-baked] charts that
are new to 2016, you can't add text boxes inside a chart
(meaning they won't move with your chart), so you
need to group them with your chart. Grouping objects
with your chart is kind of like adoption for data. Aww!

Resize Fonts

| usually like to bump up the font size on chart titles to
make them stand out more. | also sometimes increase
the font size in legends. To adjust the font size, select
the item and navigate to Home » Font Size and
choose the size from the drop-down menu. Or use the
Increase Font Size or Decrease Font Size buttons to
the right for incremental changes.

Adjust Chart Series Spacing

Bar and column charts sometimes look a little better
if the bars are wider. To adjust them, select a bar to
select the entire data series and press Command-1 to
open the Format Data Series pane. Next, open the
Series Options tab and reduce Gap Width using
the slider or entering the percentage (Fig 3.59). I'll
usually fatten up my bars to make room for data
labels. With the extra space, you may also want to
bump up the font size of your labels and/or make the
font bold.

Fig 3.59: Fatten up your bars by reducing
Gap Width.



Fig 3.60: A viewer can always get the exact date by hovering over a data point.

Thin Out Axes
There are two issues | commonly see with axis labels:

+ Labels are turned sideways: This is one of my great-
est pet peeves with chart design. Sometimes this
happens because the chart designer used a [vertically
oriented] column chart when she should have used
a [horizontally oriented] bar chart. This is addressed
in the Bar Chart and Column Chart tutorials. But,
as a general rule, if your x axis isn’t charting a time

element, use bar charts when you're working with
datasets that have longer labels.

+ Axes are unnecessarily dense: Sometimes your axis
labels are unnecessarily detailed, exceeding that
optimal noise/signal ratio we're aiming for. Excel
allows you to set the interval for your axis to give
you some breathing room. To access these options,
select your axis and press Command-1 to open the
Format Axis pane.

We push Excel a little too far in the Cycle Plot tutorial—
causing it to crumble into a ball on the floor and scream
uncontrollably like a toddler who missed naptime—~but
most times this technique is fairly reliable. That said,
there are some nuances, depending on the type of
data that's referenced in your axis, so we'll address
the strategies for each data type separately.
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Date Axes

| often see charts with dates in the horizontal axis,
but the chart designer will do silly things like have
the full date representing each day of the month,
for example, and then turn the labels on their side
because there's no room in the axis. | call it silly
because indulge me for a second: You're reporting
on the performance of something from last month,
and you're telling me the month started with 6/1/2018,
followed by 6/2/2018, followed by 6/3/2018...See
where |I'm going with this?

You can put the year (and even month) elsewhere in
your worksheet: the chart title, the worksheet title,
an annotation...anywhere but your axis labels, where
real estate is precious.

With year taken care of, we can still shave our axis
labels down more. You could easily skip every other day,
and no one will panic and ask, “Wait, what about even
days? What kind of dystopian society did | wake up in
today?” I've seen charts skip as much as six days at
a time, and I've still been able to interpret the chart
with no issue. If a viewer wants to see the exact date
experienced that spike (or precipitous drop), he can
hover over a data point and see the date (Fig 3.60).
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(- THIGIWYD]NY See the Customize Number Format-
ting section of this chapter to learn how to finesse
your number formatting.

To this end, Excel gives you some extra options with a
date axis. The one | use most is the Major Units setting
in the Format Axis pane (Fig 3.61). Regardless of
what format my dates take (e.g., month, days of week,
date), | usually bump Major Units up from 1 to 2. If you
set your number formatting to mmm for months only,
ddd for days of the week, mm/dd for month and day
(with leading 0s), or m/d, skipping one unit will result
in a lighter axis without sacrificing clarity. You'll put this
technique to good use in the Line Chart tutorial.

Value Axes

For all other axis-thinning options, you'll just adjust the
Major Units under Axis Options (Fig 3.62). | often
find doubling the default value gives me the light and
airy axis my minimalist soul craves. In the accompany-
ing screenshot, the original value was 5000. | bumped
it up to 10000. (Thousands separators need not apply
in these settings.)

Fig 3.61: Thin out a date axis
by bumping up the Major
Units setting.

Fig 3.62: Hardcode Major Units
setting to thin out a value axis.
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Warning: If you plan to create a chart template from your
chart (something you will learn all about in the next chap-
ter), you should first create the template (right-click »
Save as Template) before customizing your axis.
If you customize your value axis (usually the y axis)
before you create the template, you will hardcode
the major units for all future charts.

L JHIGIWYD]NY See the Create a Store of Chart
Templates section of the Set It and Forget It chapter
to learn how to work with templates.

Text Axes

You may be wondering, Why would | want to thin out
a text axis? In most cases a text axis is the default for
categorical data: region, marketing channel, country,
employee, gender, etc. You obviously wouldn't want to
remove every other region or employee in your depart-
ment. However, sometimes you will have dates show
up as text. For example, if the dataset you're handed
has hardcoded months as abbreviations (Jan, Feb,
Mar), Excel will treat them as text. Same with days of
the week. (I've seen it all and have suffered so you don't
have to! #messiahcomplex)

You can see an example of a date column that is
treated as text in the Lollipop Graph tutorial, as well
as the Add a Target Line variation of the Line Chart

tutorial. In this case, you can thin out them out in
the Labels section of the Axis Options tab of the
Format Axis pane. Set Interval between labels to
your desired amount (Fig 3.63). (I usually set mine
to 2, but if you're working with months you could just
as easily show only the first month of each quarter
without loss of understanding.)



Fig 3.63: Thin out text axes by setting the interval unit.

Remove Unnecessary Axes

If you use data labels in your charts,
you may no longer need your axis. To
remove it, select it and press Delete on
your keyboard (Fig 3.64).

Add an Axis Title

Sometimes it's important to add an axis
title to your chart. One reason might be
that you have two axes, as you do with
a combination chart.

Warning: If you're creating a scatter plot you'll need to
manually add axis titles. I'm surprised Excel doesn't add
them by default because there's no way to know which
value is plotted on which axis without them.

To add one, select the chart and navigate to Chart
Design » Add Chart Element » Axis Titles. From the
flyout menu you can choose Primary Horizontal or
Primary Vertical. If you want more options, choose
More Axis Title Options, which will open the Format
Axis Title pane.
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Fig 3.64: Don’t be afraid to delete your value axis if you're using data labels.

When you add a title, Excel places it a little too close
to the axis for my taste, at least for vertical axes. If
you're uncomfortable with its lack of boundaries too,
you can drag it away while holding down the Shift key
to keep it vertically centered or drag the sizing handle
on the left side of the Plot Area to move it over. To
enter your text, either double-click inside the title box
and start typing or select the title box and type your
title in the Formula Bar.
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Add Markers

Some chart types consist primarily of markers, as
you'll see in the Dot Plot, Dumbbell Plot, and Scatter
Plot tutorials. In other charts markers are merely

an augmentation, as you'll see in the Slope Chart,
Sparklines, Line Chart, and Stock Chart tutorials.

If your chart has a marker option, you'll be able to
add them by selecting your data series and pressing
Command-1 to open the Format Data Series pane.The
Marker options are housed under the Fill & Line tab.

Excel gives you a few formatting options for your markers:

+ Type: You have a number of shapes to choose from.
This book will only use the circle option. | personally
find charts that mix types busy and amateur. Also,
one marker type might look bigger or smaller than
another marker type of the same size. Just because
you can do something doesn’t mean you should.

+ Size: Don't be afraid to play with this setting. Using
larger markers can give your chart a trendy feel.
Because most Excel users don't play with size,
you'll automatically show yourself to be a cut above.

+ Fill: You can play with both the color and transpar
ency of your fill color. | will sometimes add transpar
ency to my marker fill to make my border pop.

+ Border: Make sure your border serves a purpose.
| mostly use them if | want a white fill (as you'll see
in the Add Sizzle variation of the Line Chart tutorial)
or I'm increasing the transparency of my markers
(as you'll see in the Bubble Chart tutorial) or data

series (as you'll see in the Use Area Chart variation
of the Combination Chart tutorial).

Hack Excel’s Charting Engine

As you'll see in the Slope Chart tutorial (which spot-
lights one of the more galvanizing datasets in the
book), there are times you'll need to modify a data
series (i.e., acolumn of data in a dataset). And, as you'll
see in the Dumbbell Plot, Add Categories variation
of the Scatter Plot tutorial, and Add a Mean Line
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Fig 3.65: We will deconstruct the Select Data Source dialog.

variation of the Bar Chart tutorial, there are other
times you'll need to create a data series from scratch.
You'll need to summon the Select Data Source
dialog (Fig 3.65). I'll dedicate this section to demys-
tifying what | believe to be Excel’'s most confusingly
labeled dialog.

Scariest Dialog in Excel?

This dialog was one of the more intimidating menus in
Excel to me for years. | only went into it and modified
it if a tutorial walked me through the steps. And even
then, I was convinced when | clicked OK to close it, my
chart would vomit all over itself like a college kid after
playing beer pong for the first time.

But the Select Data Source dialog—which you get
to by right-clicking anywhere inside a chart and
selecting Select Data from the contextual menu—
is to charts what creepers are to auto mechanics.
(Not this kind of creeper: bit.ly/mdsem-creep.)
It's how you access the underbelly of your chart to
restructure it.


http://bit.ly/mdsem-creep

Anatomy of the Select Data
Source Dialog

Let's break down the Select Data
Source dialog a bit. | think one of
the problems with this dialog is
Microsoft engineers got a little...
enthusiastic...with the labels.
But they actually make sense
once you learn to interpret them.
| kind of picture the engineers
calling for a brainstorm meeting
to determine how to label the
features in this dialog and then
shoehorning all the terms on the
whiteboard into the dialog.

Chart Data Range

Ah.The most intuitive label in the dialog, in my opinion.
No complaints on this one. As the label suggests, this
field references the range of cells in your dataset that
are included in the chart. If you click inside this field,
your range will suddenly find itself surrounded by an
army of marching ants.

These columns are oftentimes contiguous (touch-
ing) but don't have to be. You can click-and-drag over
a column of data, hold down the Command key and
click-and-drag over another column. Technically, this
can be a row of data, if your data is structured using
rows instead of columns, but all the datasets used in
this book are structured using columns, which is more
the norm. If your columns aren’t contiguous, you'll
see them separated with a comma in the Chart data
range field (Fig 3.66).

You'll notice an icon next to this field with a red arrow
and blue square. You'll see these all through the
Select Data Source dialog. If you click it, the Select
Data Source dialog will be reduced to just that field,
which is intended to make it easier for you to click-
and-drag over the data range you want represented in
the chart (Fig 3.67).
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Fig 3.66: Non-contiguous ranges are separated by a comma.

Fig 3.67: Excel allows you to remove all distraction when selecting a
new data range.

You don’t need to click this button to select a range.
You can, instead, click inside the field, delete what's
in there, if anything, and click-and-drag over the
range of columns in your dataset you want included
in the chart.
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Legend entries (Series)

THINK METRICS PLAYGROUND

This area of the Select Data Source dialog was
the most confusing to me. This is just where your
data series reside. And because data series (e.g.,
individual lines in a line chart or columns of the same
color in a clustered column chart, etc.) are differen-
tiated in the legend, Microsoft engineers decided to
lead with that. | think they did users a disservice
with this label because the legend is really more
secondary. You don’'t open Excel, crack your knuck-
les, and tell yourself, Today's the day | put the legend
in legendary!

| suggest that you just think of this section as simply
where your metrics go: revenue, runs batted in,
miles, interest rate, website visits, revenue, etc.
If you can measure it with a number, it most likely
goes in this section. Therefore, whenever you go
into the Select Data Source dialog (which you will
do a lot throughout the course of this book), maybe
switch out that label in your mind with something like
Metrics. It might help.

Fig 3.68: Click the + button to manually add a data series.
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ADDING AND EDITING DATA SERIES

You can add a new data series by clicking the + button
and edit a data series by selecting it in the Legend
entries (Series) field and using the Name and Y
values fields (Fig 3.68). Whatever you put in the Name
field will replace Seriesx (Series2 in the screenshot).

In most cases, you won't need to fill out the Horizontal
(Category) axis labels field (Fig 3.69). By default,
Excel uses the first column of your dataset to fill this
area of the Select Data Source dialog. You mostly just
need to manually add data series when modifying a
chart or creating a hack chart, as you'll do quite a bit in
this book! Sciiience ruuules!

Note: The Select Data Source dialog will include an
X values field when you're working with charts that
include x values, as you'll see in the Dot Plot, Scatter
Plot, and Bubble Chart tutorials.

To set Name, you can either type your series name
in (not recommended) or click inside the field, then
select the column header of the column you're adding.
To set Y values, delete the ={1} that auto-populates

Fig 3.69: The Select Data Source dialog sometimes includes an
X values field.
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Fig 3.70: Add new data series manually in the Select Data Source dialog.

this field, and click-and-drag over just the values of Bubble Chart tutorials), the Select Data Source dialog
your new column of data. To speed this up, select will split the series values into x values and y values.
the first cell, then hold down the Command and Shift When you click inside the X values field, the marching

keys while pressing the down arrow
key on your keyboard to select all
contiguous cells in your column. If
you have blanks in your data (tsk
tsk), it might be faster to scroll to
the bottom of the column and Shift-
click the last cell. (If it's a really large
dataset, I'll scroll way down, to
where | know there are blank cells,
then Command-click to pop up to
the closest non-blank cell.) Then
click OK to close the Select Data
Source dialog (Fig 3.70).

WHEN YOUR DATA SERIES
HAS X AND Y VALUES

If you're working with a chart type
that uses x and y values (as you'll
see in the Dot Plot, Scatter Plot, and

Fig 3.71: If you have x and y values, your Select Data Source dialog will add an extra field.
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ants will surround the values you're plotting along the
x (horizontal) axis (Fig 3.71). This may cause some
flashbacks to middle school algebra. If so, | apologize.
Nobody deserves that.

With a scatter plot, for example, individual data
points are determined by both their x value and y
value. You travel across the horizontal axis to find
the x value and then move parallel to the vertical
axis to find the y value. But we'll also use this ability
to set x and y values to create charts Microsoft engi-
neers didn't anticipate us greedy little Excel users to
try to create in Excel, as you'll see in the Dot Plot
tutorial. Muahaha!

Fig 3.72: Exhibit A: Category labels aren’t always along the horizontal axis.

Fig 3.73: Excel only needs the categories; the header need not apply.
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Horizontal (Category) Axis Labels

THINK CATEGORIES PLAYGROUND

Again, in my opinion, this is an unnecessarily compli-
cated label. This area of the dialog is very simply where
your categories go: department, region, team, school,
smart phone brand. You get the idea. And the word
horizontal shouldn't even be in there because axis labels
aren't always in the horizontal axis (Fig 3.72).

By default, Excel uses the first column of your dataset
to fill this area of the Select Data Source dialog. If
you click inside the Horizontal (Category) axis labels
field, you'll see marching ants around the categories
you're charting. Excel doesn't care about the column
header, only the categories. So, if you must manually
select your categories, don't include the header in the
selection (Fig 3.73).

CATEGORIES GONE WILD

With some of the non-standard charts
we'll build, you'll see the flexibility of
the Horizontal (Category) axis labels
field (Fig 3.74). For example, you'll see
in the Show % Change variation of the

Clustered Column tutorial that we will

pass two columns into our categories
(Fig 3.75).

Loosely related: You will adore pivot
tables [almost] as much as | do when
you see how easy it is to calculate
year-over-year % difference. Go ahead
and create this chart for your boss and
see what happens. I'm telling you...
Nothing says job security quite like a
YoY % delta chart!

And in the Diverging Stacked Bar Chart
tutorial we'll use multiple category

variables: survey questions and survey
responses (Fig 3.76). This is a hacked
chart type but oh so sexy—and a great
way to visualize survey data (Fig 3.77)!
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Fig 3.74: Nothing says job security quite like a YoY % delta chart!

Fig 3.75: Can you say bogo deal on axis categories? Fig 3.76: Two! TWO categories! Ah ah ahhh!

Fig 3.77: The diverging stacked bar chart is a great way to visualize survey data.
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Switch Row/Column
As you might imagine, this button allows you to switch
your rows and columns (Fig 3.78).

We'll need to use it in our 100% Stacked Bar Chart tuto-
rial (if you're following along with the sample dataset)
because sometimes Excel will ignore the way your data

is structured and do what it thinks is best. It'll make
sense when you read through the tutorial.

Fig 3.78: Sometimes you need to switch rows and columns.

We'll also use it create some sophisticated, non-stan-
dard charts, as you'll see in the Slope Chart tutorial.

Add Data Series to Chart
You will occasionally need to add new data series to
charts. You have three ways to add them:

+ Drag sizing handles: When you click anywhere in
your Plot Area, you'll see purple, red, and blue
highlighting in your dataset. These indicate the cate-
gories, series name, and series values, respectively.
Click-and-drag the handle in the bottom-right corner
of the blue outlined area to add contiguous (touch-
ing) data to the chart.
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+ Copy-and-paste: Click-and-drag over your new
column (including the column header) to select
it, then copy it, select your chart's Plot Area, and
paste it into your chart.

+ Select data: Right-click anywhere in the Plot Area,
choose Select Data from the contextual menu, and
add your new data series by clicking the + button
in the Legend entries (Series) section. See the
previous_ Anatomy of the Select Data Source Dialog
section to learn how to use this dialog. | break it
down in the simplest terms.

COPY-AND-PASTE TIPS

You will employ a variety of paste options throughout
the tutorials in this book. For starters, it's import-
ant to know that the keyboard shortcut to copy is
Command-C and paste is Command-V. But you have
several advanced paste features you will use in creat-
ing visualizations.

For consistency's sake, we'll access all the paste
options by right-clicking in a cell and choosing Paste
Special to open the Paste Special dialog.

Paste as Values

We wiill use pivot tables to get our data in the struc-
ture we need for many tutorials. But if you create
a chart from a pivot table and there's a pivot chart
version of your chart option, Excel will use a pivot
chart. The problem with this is pivot charts are diffi-
cult to finesse, in my opinion. I've never preferred
them because of their design limitations. The way
we'll get around this is to copy only what we need
from the pivot tables we create and paste as values
into the worksheet we'll be building the chart in. In
real life | never put raw data in the same worksheet
as my visualizations. | only do it in this book so that
it will be easy for neophytes to reference the data
that's being charted.

You can copy/paste as values through the Paste
Special dialog. Choose Values and number formats



Fig 3.79: The Paste Options button is my favorite way to paste as values.

to maintain your number formatting, if you customize
it before pasting (Fig 3.79). If you haven't customized
it, you can just choose Values. \With experience, deci-
sions like this will become second nature.

Alternatively, you can paste your range, then choose
Values or Values and Number Formatting from the
Paste Options button that appears in the bottom-right
corner of your pasted range.

Note: | won't necessarily always differentiate between
the two options in the tutorials. You decide which is
better for you.

Calculate on the Fly

Excel allows you to do quick math by copying a value
from a cell, selecting a range you want to apply the
calculation to, and choosing a calculation option under
Operation in the Paste Special dialog (Fig 3.80).
You can add, subtract, multiply, and divide. You'll see
how we use this option to make values negative to
move bars to the left of our y axis in the Diverging Bar
Chart tutorial.

Copy Column Widths

Sometimes, when you're cleaning up your workspace,
you might find that you have columns that have vari-
able widths because of data that once resided there.
And when you're creating dashboards, you'll some-
times want to standardize your column widths across

CHAPTER 3 - DESIGN WITH ELEGANCE

Fig 3.80: Do math on the fly in the Paste Special
dialog. #mathlete

some of your visualizations. Excel has your back with
its option to copy-and-paste column widths. You can
access this option in the Paste Special dialog, under
the Paste section.

Transpose

As you saw in the Hack Excel's Charting Engine section,
if your data charts with the wrong configuration, you
can use the Switch Row/Column button. But you can
switch your rows and columns before you create your
chart with the Transpose option. Access this option at
the southern tip of the Paste Special dialog.
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Paste Visible Cells Only

If you copy-and-paste a range with hidden rows or
columns, they become unhidden. We don't have the
option to paste only the visible cells in the Paste
Special dialog, but we do in the Go To dialog, which
we get to by pressing F5 or Control-G (Fig 3.81). If you
forget the keyboard shortcut (as | usually do), you can
access the Go To dialog from the Edit menu by navigat-
ing to Edit » Find » Go To. In the Go To dialog, select
the Special button to open the Go To Special dialog.
Select Visible cells only, then navigate to where you
want to paste your range, and paste as usual.

Warning: Be careful to not paste your visible cells into
a range that includes hidden rows or columns or your
data will be jumping out of the frying pan into the fire.
(Translation: They will be hidden. | may or may not be
writing from personal experience. #smbh)

Fig 3.81: Select only visible cells from the Go To
Special dialog to prevent pasting hidden cells.

Move Without Pasting

When you select a range, you can drag it without copy-
ing and pasting, but it's a little tricky. And | can't grab a
screenshot because of conflicting keyboard shortcuts,
so I'll have to walk you through it sans screenshot.

First, select a data range you want to move, then hover
over any edge of the selection. Your cursor will become
a hand. Now Shift-drag the selection where you want it.
You'll see guides letting you know where you're about
to drop the range.

Paste Chart Formats

Let's say you format a chart exactly the way you
want it (the chart on the left). Then you want to
create another chart just like it, so you create the
second chart...the kinda derpy chart on the right
(Fig 3.82).

You can simply copy its format and paste it onto the
new chart. To start, select your initial chart, then copy
it and select your new chart. Then navigate to Home »
Paste » Paste Special. This will open a tiny version of
the Paste Special dialog (Fig 3.83). Choose Formats
and click OK to close the dialog (Fig 3.84).

Fig 3.83: Aww, a baby
Paste Special dialog!

Fig 3.82: We'll copy the format from the chart on the left onto the chart on the right.
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Fig 3.84: Copying chart formatting isn’t a perfect solution, but it’s a great option for ad hoc analysis.

You may still need to do some cleanup, but it's a great
way to get you close to your finished product. The only
thing that didn't copy over was my Chart Area border,
but that's easily fixed.

As you'll see in the Set It and Forget It chapter, if you
plan to use a chart type more than once, you should
create a chart template from it. Learn more in the

Create a Store of Chart Templates section.

BRING SEXY BACK

If at any point you regret your minimalist ways and want
to add elements back in, you can do that by selecting
your chart and navigating to Chart Design » Add Chart
Element (Fig 3.85).

Fig 3.85: Easily add chart elements back into your chart via the Add Chart Element drop-down menu.
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